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Authors, please fill out the brief questionnaire below.   

A.  Will you require JoVE to record video microscopy, such as filming a complex dissection or microinjection technique? (Y/N) No
B.   Does your protocol include detailed, step-by-step, descriptions of software usage? (Y/N) Yes (steps 5-8) 
C.  Which steps of your protocol will viewers benefit most from having filmed? Please list 4-6 steps. Steps 2-4 for on filming day, the later steps (5-8) in the video.
D.  What is the single most difficult aspect of this procedure and what do you do to ensure success? Data analysis, follow a checklist (these are computer steps, so I believe I am meant to prepare screen recordings so this won’t be part of the filming day?)

1. Introduction (Schematic Overview and Interview)

A. Schematic Overview (read by voice talent at JoVE):

Procedural Narrative:
The overall goal of this procedure is to identify protein interaction partners for a given protein of interest. (Intro)

This is accomplished by first growing the cells in cell culture media containing arginine and lysine labeled with different stable isotopes of carbon and nitrogen. (P1: Display the title for part 1 of the graphic overview on the top of the screen. Then have each bottle appear sequentially with the corresponding labels. Replace the label “(R0K0)” with “add 12C6 L-arginine and 12C6 L-lysine”. Replace the label “(R6K4)” with “add 13C6 L-arginine and 4,4,5,5-D4 L-lysine”. Replace the label “(R10K8)” with “add 13C6 15N4 L-arginine and 13C6 15N2 L-lysine”. Have these new labels displayed inside the bottles and do not include the quotations for these labels when implementing them.)

The second step is to transfect plasmids encoding a protein of interest or a control plasmid into the labeled cells. (P2: Display the title for part 2 of the graphic overview at the top of the screen then below the title have the image of the GFP vector displayed on the left side of the screen when the words “transfect plasmids” is read. Then have the arrow appear to the right of the image with the label “transfect” above it. Then have the image of the plate appear to the right of the arrow and then have image of the pipette tip appear and then have the two drops appear below the tip sequentially when the words “into the labeled cells” are read.)

Next, the cells are lysed and samples are immunoprecipitated from the lysates. Then, equal volumes of control and sample immunoprecipitates are combined and submitted for LC-MS/MS analysis. (P3: Display the title for part 3 of the graphic overview at the top of the screen and have the image for part 3 appear on screen when the first sentence is read. Then for the second sentence show a clip of shot 4.4.1. and shot 4.4.2. on screen. )

The final step is to analyze the mass spectrometry data to identify proteins interacting with the protein of interest. (P4: Display part 4 of the graphic overview with the title at the top of the screen. Highlight the bars on the graph shown to the right of the dotted line when the words “to identify proteins interacting” are read.)

Ultimately, stable isotope labeling of amino acids in cell culture (or SILAC)-( this is pronounced correctly at the beginning of another JOVE paper (http://www.jove.com/video/1225/identification-protein-complexes-with-quantitative-proteomics-s)) immunoprecipitations are capable of identifying large numbers of both direct and indirect interactions with a protein of interest from tissue culture cells. (P5: Display figure 4A without the gradient scale at the bottom. Have an arrow point to the green 4A with the label “protein of interest” then have an arrow point to the red 4G with the label “direct interaction” and then have a few arrows point to the proteins that are a lighter shade of red with the label “indirect interactions”)

[image: ]


Paste a copy of your graphic overview here.  The original file should be Adobe Illustrator (preferred) or Powerpoint (see instructions) and should be uploaded through your online submission on the JoVE website. Please keep all layers in the file (i.e., do not flatten the file).   


B.  Interview: (Said by you on camera. Don’t forget to smile!)  
1.1. Ed Emmott: The main advantage of this technique over existing methods, like TAP-tagging, is that it doesn’t rely on the investigator sending individual bands for mass spectrometry, which removes an important source of bias whilst increasing sensitivity.   
1.2. Ed Emmott: Though this method can provide insight into cellular protein-protein interactions, it can also be applied to other systems, such as pathogen-host interactions.


Protocol (read by voice talent at JoVE):
2. Harvesting of SILAC-Labeled Cell Lysates
2.1. To begin, scrape SILAC-labeled HEK293T cells expressing the GFP-tagged protein of interest, or GFP control, from the cell culture dish into ice cold PBS. Then, centrifuge the cell suspension at 220 x g for 5 minutes at 4°C. Wash the cells three additional times in 10 mL of ice cold PBS.
2.1.1. WIDE: Talents takes plate of cells out of the incubator.
2.1.2. MED over the shoulder: Talent scrapes the SILAC-labeled HEK293T cells in ice cold PBS and transfers to centrifuge tube.
2.1.3. WIDE: Talent places cell suspension in centrifuge and presses start.
2.1.4. MED: Talent resuspends cell pellet in 10 mL of ice cold PBS. (TEXT: Repeat wash step 3 times.)
2.1.5. WIDE: Talent places cell suspension in centrifuge and presses start.
2.2. Resuspend the cell pellet in 200 μL of cell lysis buffer containing freshly added protease inhibitor cocktail III at 1X concentration and add 5 μL of RNAse cocktail per mL of lysis buffer. Incubate on ice for 5 minutes. (TEXT: 10mM TrisCl pH7.5, 150mM NaCL, 0.5mM EDTA, 0.5% NP40)
2.2.1. MED: Talent resuspends cell pellet in 200 uL of cell lysis buffer. 
2.2.2. CU: Talent adds 5 uL of RNAse cocktail per mL of lysis buffer to cell suspension, places on ice, and presses start on a timer set for 5 minutes.
2.3. Then, centrifuge the cell lysate at 13,000 x g for 10 minutes at 4°C and retain the supernatant as the soluble cell lysate.
2.3.1. MED: Talent places cell suspension in centrifuge and presses start.
2.3.2. MED: Talent removes tube from centrifuge.
2.3.3. CU: Talent transfers supernatant into a new tube.
2.4. Measure the protein concentration of the cell lysate using a BCA assay. Then, normalize the protein concentration in each sample lysate in a final volume of 500 μL using the lysis buffer containing protease inhibitors.
2.4.1. MED: Talent measures the protein concentration of the cell lysate using a BCA assay.
2.4.2. MED: Talent normalizes the protein concentration in each sample lysate in a final volume of 500 uL of lysis buffer containing protease inhibitors.
2.5. Add 500 μL of dilution buffer containing 1X protease inhibitor cocktail III to each of the normalized cell lysates to adjust the total volume to 1 mL. Keep lysates on ice while preparing anti-GFP beads and retain a 50 μL aliquot of each sample to be used for sample input. 
2.5.1. CU: Talent adds 500 uL of dilution buffer containing 1X protease inhibitor cocktail to each normalized cell lysate. (TEXT: 10mM TrisCl pH7.5, 150mM NaCl, 0.5mM EDTA)
2.5.2. MED: Talent transfers 50 uL from each sample into a new tube and places samples on ice.
3. Binding Lysate to anti-GFP Beads
3.1. Vortex the bead slurry to resuspend the beads. Then, use a 200 μL pipette tip with the end cut off to transfer 25 μL of beads per sample to a fresh tube. 
3.1.1. MED: Talent vortexes the bead slurry. (TEXT: Prepare the beads as a mastermix for each experiment to minimize sample to sample variation.)
3.1.2. CU: Talent uses a 200 uL pipette tip with the end cut off to transfer 25 uL of beads for each sample to a new tube.
3.2. For each 25 μL of bead slurry, add 20 volumes of dilution buffer to wash. Centrifuge the beads at 2,700 x g for 5 minutes. Wash the beads two additional times with 20 volumes of dilution buffer. 
3.2.1. CU: Talent adds 20 volumes of dilution buffer to each tube of beads. (TEXT: 1500 μL of dilution buffer per 75 μL slurry)
3.2.2. MED: Talent places tubes in centrifuge and pushes start. 
3.2.3. CU: Talent removes supernatant from beads and adds another 20 volumes of dilution buffer. (TEXT: Wash beads 3 times.)
3.3. Next add 100 μL of dilution buffer per 25 μL of bead slurry. Then, use a 200 μL pipette tip with the end cut off to transfer 85 μL of the resuspended bead slurry to each of the SILAC-labeled sample lysates.
3.3.1. WIDE: Talent removes tubes from centrifuge.
3.3.2. MED: Talent adds 100 uL of dilution buffer to each tube of beads and then transfers 85 uL of bead suspension to each SILAC-labeled sample lysate.
3.4. Incubate the samples with beads on a rotator at 4°C for 2 hours. 
3.4.1. WIDE: Talent places samples on a rotator at 4°C and pushes start on a timer set for 2 hours.
4. Preparation of Samples for MS Analysis
4.1. After the samples have incubated with the beads, centrifuge the samples at 2,700 x g for 5 minutes at 4°C. Retain 50 μL of the supernatant as the unbound sample and discard the remainder of the supernatant. 
4.1.1. WIDE: Talent places tubes in centrifuge and pushes start.
4.1.2. MED: Talent transfers 50 uL of the supernatant to a new tube for each sample and discards the remaining supernatant. (TEXT: Pipette through a P2 tip with its end crushed to help avoid removing beads)
4.2. Resuspend the beads in each tube in 1 mL of dilution buffer and then centrifuge at 2,700 x g for 5 minutes at 4°C. Repeat this wash step twice.
4.2.1. CU: Talent resuspends the beach in 1 mL of dilution buffer.
4.2.2. MED: Talent places tube in centrifuge and presses start. (TEXT: Repeat wash step 2 times.)
4.3. To elute the protein from the beads, add 50 μL of 2x SDS loading buffer to each sample and heat at 95°C for 10 minutes. Once the heating is finished, centrifuge each sample at 2,700 x g for 5 minutes at 4°C.
4.3.1. MED: Talent adds 50 uL of 2X SDS loading buffer to each sample and then places samples at 95°C and pushes start on a time set for 10 minutes.
4.3.2. WIDE: Talent places tubes in centrifuge and pushes start.
4.4. Transfer the supernatant to prelubricated tubes and store at -80°C until ready to submit for MS analysis. Then, mix equal volumes of control and sample immunoprecipitates and submit the combined sample to a mass spectrometry facility for LC-MS/MS analysis.
4.4.1. MED: Talent transfers supernatant to prelubricated tubes and then mixes equal volumes of control and sample. 
4.4.2. WIDE: Talent drops off samples at mass spectrometry facility.
[bookmark: _GoBack]Note to editor – we post off out samples on dry ice to a facility in Bristol, so shot was modified to show samples being placed on dry ice and then leaving the room with the parcel.
5. Data Analysis I: Understanding the Results and Removal of Low-confidence Identifications
5.1. Prior to analyzing the mass spectrometry data, copy the raw data into a new spreadsheet. Then, in this spreadsheet remove all the columns except for the columns containing the accession number, number of unique peptides, ratios comparing samples, ratio variability, and the protein description. (TEXT: Replica experiments should be combined into one spreadsheet.)
5.1.1. MED over the shoulder: Talent works on the computer in Excel and copies raw data to a new spreadsheet. Then, Talent removes all columns in the spreadsheet except for the columns containing the accession number, number of unique peptides, ratios comparing samples, ratio variability, and the protein description.
Author: Added optional screencap versions of this as potential alternatives as not completely sure this worked well by camera (Replace or not at editors discretion). File: 5_1_1a.mov contains section: : ‘Talent works on the computer in Excel and copies raw data to a new spreadsheet’., File: 5_1_1b.mov contains section: ‘Talent removes all columns in the spreadsheet except for the columns containing the accession number, number of unique peptides, ratios comparing samples, ratio variability, and the protein description’.
5.2. Use the Excel ‘sort’ function to order the data by the number of peptides and remove the entries for proteins lacking more than one peptide. Then, sort by ratio and remove proteins that lack SILAC ratios. 
5.2.1. SCREEN: Screen capture footage as talent uses the Excel ‘sort’ function to order the data by the number of peptides and removes the entries for proteins lacking more than one peptide. The talent then sorts by ratio and removes proteins that lack SILAC ratios.
File: 5_2_1a.mov contains the section: ‘Screen capture footage as talent uses the Excel ‘sort’ function to order the data by the number of peptides and removes the entries for proteins lacking more than one peptide’.
File: 5_2_1b.mov contains the section: ‘The talent then sorts by ratio and removes proteins that lack SILAC ratios. The talent then sorts by ratio and removes proteins that lack SILAC ratios’.
5.3. Next, convert SILAC ratios to log2 values using the formula: ‘=log(SILAC Ratio,2)’,  where ‘SILAC Ratio’ is substituted for the cell identifier. 
5.3.1. SCREEN: Screen capture footage as talent converts the SILAC ratios to a log2 values using the formula: ‘=log(SILAC Ratio,2)’ and substitutes ‘SILAC Ratio for the cell identifier.
File: 5_3_1.mov
5.4. Then, create a new column in the Excel file and calculate log2 SILAC ratios for all the sample/mock columns. For conversion of a mock/sample ratio to a sample/mock ratio, use the formula: “=1/ratio”.
5.4.1. SCREEN: Screen capture footage as talent creates a new column and calculates the log2 SILAC ratios for all the sample/mock columns and converts any mock/sample ratio to a sample/mock ratio using the formula “=1/ratio”.
File: 5_4_1a.mov covers the section: ‘Screen capture footage as talent creates a new column and calculates the log2 SILAC ratios for all the sample/mock columns’
File: 5_4_1b.mov covers the section: ‘and converts any mock/sample ratio to a sample/mock ratio using the formula “=1/ratio”’. Note for editor, this section is optional and may or may not be necessary so whilst it is important to include, it only needs a brief mention.
6. Data Analysis II: Selecting High Confidence Interactions for Further Study
6.1. Open Graphpad Prism, select New>Data Table and Graph. Select ‘column’ from the list on the left hand side of the window, and select the Enter/Import data>Enter replica values, stacked into columns options. Press ‘Create’.
6.1.1. Med over the shoulder: Talents opens Graphpad Prism on the computer.
6.1.2. SCREEN: Screen capture footage as talent clicks on new then selects data table and graph. Talent then selects a column from the list on the left hand side of the window and clicks on Enter/Import data and then selects enter replica values, stacked into columns option. The talent then clicks on ‘create’.
File: 6_1_2.mov
6.2. Then, select and copy a given log2 Sample/Mock SILAC ratio column from the Excel spreadsheet into the new Prism file.
6.2.1. SCREEN: Screen capture footage as talent selects a given log2 Sample/Mock SILAC ratio column from the Excel spreadsheet and copies it into the new Prism file.
File: 6_2_1.mov
6.3. Next, click the dropdown ‘Insert’ menu and select ‘New analysis’. Under column analysis select ‘Frequency distribution’. Keep the default options and click ‘OK’.  
6.3.1. SCREEN: Screen capture footage as talents clicks on the ‘Insert’ dropdown menu and then selects ‘new analysis’. Talent then selects ‘Frequency distribution’ under column analysis and chooses the option to keep the default options and then clicks ok.
File: 6_3_1.mov
6.4. In the ‘Results’ folder a new ‘Histogram’ section will have been generated. Select the frequency distribution section. Then, click the dropdown ‘Insert’ menu and select New analysis>XY>Nonlinear regression (curve fit). Click on ‘Gaussian distribution’ and click OK.
6.4.1. SCREEN: Screen capture footage as talent views the ‘results’ folder and displays the new ‘histogram’ section. Talent then selects the frequency distribution section.  Talent then clicks on the ‘Insert’ dropdown menu and selects ‘new analysis’ then selects ‘XY’ and then selects ‘nonlinear regresstion (curve fit)’. The talent then clicks on ‘Gaussian distribution and clicks ‘OK’.  
File: 6_4_1.mov
6.5. In the results window that appears, the mean and standard deviation are given. Generate a threshold by adding 1.96 standard deviations to the mean.
6.5.1. SCREEN: Screen capture footage as a results window appears displaying the mean and standard deviation and then the talent generates a threshold by adding 1.96 standard deviations to the mean.
File: 6_5_1.mov
7. Data Analysis III: Merging Replica Datasets
7.1. Return to the Excel file, create a new tab called ‘Combined’.  Label column A ‘Accession’ and copy all the accession numbers from each of the individual experiments into this single column.
7.1.1. Med over the should: Talent works on Excel on the computer.
7.1.2. SCREEN: Screen capture footage as talent creates a new tab in the Excel file called ‘Combined’ and then labels column A ‘Accession.’ The talent then copies all the accession numbers from each of the individual experiments into the accession column.
File: 7_1_2.mov
7.2. Next, select the ‘Data’ tab, and then the ‘Remove Duplicates’ option. Then, create columns for the SILAC ratios, and ratio variability from each experiment as well as for the protein name/description column. 
7.2.1. SCREEN: Screen capture footage as talent clicks on the ‘data’ tab and then selects ‘remove duplicates.’ The talent then creates a column for SILAC ratios, a column for ratio variability, and a column for protein name/description for each experiment.
File: 7_2_1.mov
7.3. In the description tab, use the vlookup formula to collect the description of each accession number. Drag the formula down the column to fill in the protein description, and then use this formula to obtain the ratio and variability data from the individual experiments.
7.3.1. SCREEN: Screen capture footage as talent selects the first cell in the description column and inputs the vlookup formula to collect the description of each accession number. The talent then drags the formula down through the rest of the cells in the description column.
File: 7_3_1.mov
Optional (Editors discretion) File: 7_3_1b.mov shows the vlookup formula being used to fill in the other columns in this file. You may wish to use this in addition to 7_3_1.mov or not, essential it is conveying exactly the same information as file: 7_3_1.mov – this covers the information in the part of the 7.3 script I added: ‘n, and then use this formula to obtain the ratio and variability data from the individual experiments’.
7.4. To highlight interacting proteins in the combined dataset, note the threshold value for a  particular experiment. Select the ratio column and click on the Home tab, followed by Conditional Formatting>Highlight cells rules>More rules.
7.4.1. SCREEN: Screen capture footage as talent selects each ratio column individually and then clicks on the Home tab and selects conditional formatting and then highlight cells rules and then selects more rules.
File: 7_4_1incl7_5_1.mov
7.5. Then, select style ‘Classic’. Format only cells that contain ‘Cell value’, ‘Greater than or Equal to’.  In the box, type in the 1.96 standard deviation value, and click ‘OK’.
7.5.1. SCREEN: Screen capture footage as talent selects classic for the style and then chooses the option to ‘format only cells that contain’ and then selects ‘cell value’ and then selects ‘greater than or equal to.’ The talent then types 1.96 in the empty box and clicks ‘OK’.
Note: screen cap included in the 7_4_1file.
7.6. Assess the ratio variability for each positive interaction. If subtracting, the % variability would drop a ‘hit’ below the threshold value, this should be treated with caution.
7.6.1. SCREEN: Screen capture footage as talent highlights the % variability for a ‘hit’ with a ratio variability that would drop below the threshold value if the % variability was subtracted.  
File: 7_6_1.mov
7.7. Repeat this for each of the results columns and compare across experiments. Highlighted proteins identified in two or more experiments represent a high confidence interaction.
7.7.1. SCREEN: Screen capture footage as talent scrolls through the results, which show multiple highlighted cells.   
File: 7_7_1.mov
8. Results: Identification of Translation Initiation Factor – Binding Proteins
8.1. Western Blot analysis confirmed the purification of the GFP-tagged protein of interest. The lack of a GAPDH band in the bound samples indicates that non-interacting proteins were depleted from the samples by the immunoprecipitation step. Whereas, the presence of an eIF4G band in these samples indicates known interacting binding partners were retained.
8.1.1. LABMEDIA: 51656fig2.jpg (Video editors: Display part A of Figure 2. Place a red box around the eIF4A blot for the first sentence. Then for the second sentence place the red box around the GAPDH blot and then highlight the lanes in the GAPDH that lack bands with either another colored box or an arrow when the words “the lack of a GAPDH” are read. Then have this colored box or arrow move to the same lanes in the eIF4A blot when the words “the presence of an eIF4G band” are read.)
8.2. Several of the identified eIF4A-binding proteins were conserved between the two isoforms. The proteins that interact with eIF4A are identified by the high SILAC ratio whereas non-specifically bound proteins in this experiment have ratios below 0.96.
8.2.1. LABMEDIA: Tables.xls (Table 2 tab) (Video editors: Display the table in the ‘Table 2’ tab of this file. Then highlight cells C5, C6, C7, D5, C6, and D7 when the words “proteins that interact” are read. Then highlight cells C8, C9, D8, and D9 when the words “non-specifically bound proteins” is read.)
8.3. In this diagram of the initiation factor complex, the eIF4A-binding proteins that were identified in the SILAC immunoprecipitation experiment are shaded in red to white according to the log2 SILAC ratio. The high coverage of both direct and indirect binding partners of the eIF4AI and II complexes illustrates the effectiveness of this approach for identifying protein interactions.
8.3.1. LABMEDIA: 51656fig4.jpg (Video editors: Display both part A and B of Figure 4. Add an arrow to the green 4A in both parts with a label “protein of interes.” Highlight the two gradients shown at the bottom of the figure when the words “Are shaded in red to white” are read. Then highlight the red 4G protein when the words “coverage of both direct” are read and then highlight the proteins shown in a lighter shade of red when the words “ and indirect binding partners” are read.)

9. Conclusion (said by authors on camera)
9.1. Ed Emmott: While attempting this procedure, it’s important to remember that whilst some variation in protein levels can be corrected for at the data analysis stages, it is best if this can be avoided by ensuring accurate normalization of protein input levels, and that the agarose beads used in the immunoprecipitation are not lost during washing steps. 

Provided Media

Authors, Please list all images, movie files, or 3-D rendered animations that can be included in the video per editor’s request.  The step in the script/video where these images will be inserted should be specified.   For example:

1.Schematic overview: Schematic.pptx
8.1 LABMEDIA: 51656fig2.jpg
8.2 LABMEDIA: Tables-2.xls (Table 2 tab)
8.3 LABMEDIA: 51656fig4.jpg 


Formats:  For static images we prefer .tiff, .eps, Illustrator, Powerpoint or Photoshop files at dimensions of at least 720X480 pixels and 300 dpi.  The higher resolution, the better.  Likewise any exported movie files should have at minimum these dimensions and be rendered to .mov, .mp4, or .avi files.  

Insert your media filenames here.
5_1_1a.mov
5_1_1b.mov
5_2_1a.mov
5_2_1b.mov
5_3_1.mov
5_4_1a.mov
5_4_1b.mov
6_1_2.mov
6_2_1.mov
6_3_1.mov
6_4_1.mov
6_5_1.mov
7_1_2.mov
7_2_1.mov
7_3_1.mov
7_3_1b.mov
7_4_1incl7_5_1.mov
7_6_1.mov
7_7_1.mov




General Preparation

It’s critical for a smooth and organized shoot that all reagents are accounted for, in advance.   

Any overnight or long incubation steps should be recognized and specimens/samples be prepared in advance so that prior steps can be recorded and shooting can continue with pre-prepared specimens/samples.  

All tubes/flasks should be pre-labeled neatly before we arrive.  

Ex. Luciferase assay done in 96 well plates should be labeled with negative/positive control wells and experimental samples are labeled accordingly.

You will receive more detailed preparation instructions, as well as an introduction to your videographer, closer to your filming date.
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